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I.  Introduction

We Thank You
Vertigraph seeks to provide takeoff and estimating tools that increase your profits
and effectiveness.  In addition to SiteWorx, our other software solutions include:

• BidScreen - on-screen takeoffs in MS Excel

• BidPoint - digitize quantities into any Excel workbook

• BidWorx - WBS, database driven estimating

Vertigraph also supplies scanners, plotters and digitizing tablets.  Needs assessment
and management consulting are also provided.

Our guiding principles are:

• Quality, integrity and value are our highest concerns.

• Customers are the reason we exist.

System Requirements
SiteWorx requires the following:

• Monitor with a screen area of 800 x 600 pixels or greater.

• Digitizer tablet with Wintab driver loaded.

• Pentium processor or later with at least 128MB of memory.

• A color printer.

Installation Instructions
The installation instructions are provided below.  If you have any questions, please
contact Vertigraph at 800-989-4243, 214-340-9436 or via Email at
info@vertigraph.com.
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Install SiteWorx to your Computer’s Hard Drive
Install the SiteWorx software to the computer's hard drive via compact disc or by
downloading the software from Vertigraph’s home page at www.vertigraph.com.  If
installing from the compact disc, insert the disc into the drive and follow the
instructions.  If downloading the siteeval.exe file from Vertigraph's home page, save
this file to your hard drive and run the siteeval.exe file to install.

Install the Digitizer Tablet’s Wintab Driver
SiteWorx requires a digitizer tablet.  As a result, you’ll need to plug in the digitizer
tablet and install the appropriate Wintab driver.  The Wintab driver is software that
allows you to move the mouse pointer on screen using the digitizer-pointing device
(16-button cursor or pen stylus).  Please note the following when installing the
Wintab driver:

• Please contact Vertigraph at 800-989-4243 or the digitizer
manufacturer (GTCO's telephone number is 800-344-4723) for help in
correctly installing and configuring the proper Wintab driver software.

• If the Wintab driver is already loaded, do not reinstall the Wintab
driver.  Please, uninstall the previous driver first.

• Each manufacturer of digitizer tablets has its own Wintab driver.
Different Wintab drivers are also required depending on the version of
Windows.  As a result, make sure you install the correct Wintab driver.

• After installing, configure the digitizing pointing device to operate in
relative or mouse mode.

Setup the Buttons on the cursor or pen stylus
After installing the Wintab driver software open SiteWorx and select
Options|Digitizer Buttons to configure the buttons on the digitizer pointer.

You can use SiteWorx with a 16-button cursor or pen stylus digitizer-pointing
device.  When purchasing a digitizer you have a choice of pointer; we recommend
the 16-button cursor.  You must setup the digitizer buttons before starting your first
takeoff and must have one button set to Point.

The Options|Digitizer Buttons window has a Cursor Style and Buttons tab.  The
Cursor Style tab is where you select the type of digitizing pointing device.  Here
you'll also select where the button names found at the Buttons tab come from.
Selecting Default for button names is easiest.  After making the two selections at the
Cursor Style tab, click on the Buttons tab to configure the digitizer buttons.

Please note that a sheet of paper with the recommended button assignments is
included with the users’ guide.  Additionally, the sheet of paper is saved as a pdf file
in the C:\Program Files\Vertigraph\SiteWorx\pdf Files folder as SiteWorx
Recommended Button Setup.pdf.  Tape this piece of paper to the digitizer for easy
reference.  Recommended button assignments for all digitizers except the Numonics
models are displayed below:

Button Action

0 Point (this button is required)

1 Change Existing to Proposed or from Include to Exclude and vice versa

2 New Object
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3 Stop Digitizing

4 Select an Item

7 Popup Menu

8 Delete Last Point

C Increase Elevation by specified Increment

D Decrease Elevation by specified increment

F Set Elevation (after pressing this button, the buttons change to the actions
noted on the enclosed Recommended Button Setup sheet)

If using a pen stylus, the tip button should be set to Point and the barrel button set to
Stop Digitizing.  If you have a three button pen stylus, the upper barrel button may
be set to Popup Menu.

Various sounds can be assigned to each button by selecting a sound from the drop
down list box.  If WAV File is selected from the list, click on the three-dot lookup
button to select a WAV file.  Under the Windows or WinNT folder a subfolder
called MEDIA is where you select from a collection of WAV files.  After you open
any WAV file, hear the sound by clicking on the Test button.

Locate the Command Template on the Digitizer

Digitizer command templates are supplied with the software and manual. You'll be
able to operate SiteWorx using the digitizer pointer and the command template taped
onto the digitizer.  You can also print the template saved as a pdf file by clicking on
the SiteWorx Digitizer Template.pdf file located at C:\Program
Files\Vertigraph\SiteWorx\Pdf Files.  The horizontal template is best when attached
to the bottom right edge.  The vertical template is often taped to the right edge of the
active area of the digitizer.  The template must be located inside the digitizer's active
area.

After taping the digitizer template to the active area of the digitizer, select
Options|Command Template|Locate to instruct SiteWorx which one of the two
templates you are using.  The vertical template commands run up and down whereas
the horizontal template runs from side to side.

If using the horizontal template, configure the template by clicking on Point button
when the crosshair or pen stylus tip is located over the bottom left hand corner of the
Stop Digitizing button.  A small circle is found at the correct place on the template.
Next, press the Point button again when the crosshair or pen tip is on the top right
hand corner of the minus sign button.

If using the vertical template, configure the template in a similar manner.
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Display Options
We recommend that you display the toolbar, properties, grid and elevations under the
Options menu.  If a checkmark is next to the command, the item is displayed.  If not
checked, the command is not displayed and should be clicked to display the item.

Configure Other SiteWorx Options
Several other options must be configured prior to starting your first takeoff.  As a
result, please review and/or complete the commands found under the Options menu.

For additional information see page 16

Technical Support
If you need assistance, contact Vertigraph by:

• Internet address www.vertigraph.com

• Telefax at (214) 340-9437

• E-Mail addressed to technical support at support@vertigraph.com

• Mail addressed to Vertigraph Technical Support, 12959 Jupiter Road, Suite
252 Dallas, TX 75238

• Telephone (214) 340-9436 between 8:30 a.m. and 5:30 p.m., Central Time.

For your reference, telephone numbers and web addresses of the major digitizer
manufacturers are:

• GTCO/CalComp Corporation - 800-344-4723, www.gtcocalcomp.com

• Numonics Corporation - 800-247-4517, www.numonics.com

SiteWorx License Agreement
Vertigraph, Inc.  Program License 12959 Jupiter Road, Suite 252 Dallas, TX 75238

Carefully read the following terms and conditions before using the program.  Use of
the program indicates your acknowledgment that you have read this license,
understand it, and agree to be bound by its terms and conditions.

Vertigraph, Inc. ("Licensor") grants to the purchaser of the SiteWorx Software
License ("Licensee") a non transferable license to use SiteWorx ("Licensed
Software").  Use of the Licensed Software is limited to a single terminal connected
to a single computer.  Your right to use the Licensed Software terminates upon the
violation of any provision of this License.  The Licensed Software is the SiteWorx
computer program which includes, without limitation, any form of the programs,
copies, modifications, enhancements, revisions and updates thereof, source code,
sample workbook(s), utility programs, visual/written materials and any other
documentation.  Until you obtain a registration number from Licensor, you agree that
the SiteWorx software is used for the purpose of evaluating the software only and
not for the production of income.  Licensee may not decompile the Licensed
Software from object code to source code or crosscompile or otherwise adopt or
modify the Programs.  You agree to take all necessary steps to ensure that the
provisions of this License are not violated by you or any person under your control
or in your service.  You may transfer the Licensed Software to a single hard disk.
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Licensor shall have sole and exclusive ownership of all rights, title and interest in
and to the Licensed Software and all modifications and enhancements thereof
(including ownership of all trade secrets and copyrights pertaining thereto).  This
agreement does not provide Licensee with title or ownership of the Licensed
Program, but only a right of use.  You may not copy, allow anyone else to copy, or
otherwise reproduce any part of the Licensed Software and/or documentation
without Vertigraph's written consent.

Disclaimer and Limitation of Liability: Due to the complex nature of computer
software, Vertigraph, Inc. does not warrant that the Licensed Software is completely
error free, will operate without interruption, or is compatible with all equipment or
software configurations.

Neither Vertigraph, Inc. nor anyone else who has been involved in the creation,
production or delivery of the programs or documentation shall be liable to you for
any damages of any type, including but not limited to, any lost profits, lost savings,
loss of anticipated benefits, or other incidental or consequential damages arising out
of contract, negligence, or under any warranty even if Vertigraph, Inc. has been
advised of the possibility of such damages or for any other claim by any other party.
Vertigraph's liability for damages in no event shall exceed the licensee fee paid for
the right to use the licensed software.

Vertigraph, Inc. Provides the licensed software "as is" without warranty of any kind,
either express or implied, including but not limited to, the implied warranties of
merchantability or fitness for any particular purpose.  Furthermore, Vertigraph, Inc.
reserves the right to revise the Licensed Software and documentation and to make
changes from time to time to the content thereof without obligation of Vertigraph,
Inc. to notify any person of such revision or changes.  Some states do not allow
disclaimer of express or implied warranties in certain transactions; therefore, this
statement may not apply to you.

The documentation could include technical inaccuracies or typographical errors.
Changes are periodically made to the information; these changes will be incorporated
in new editions of the publication.  Vertigraph, Inc. may make improvements and/or
changes in the Licensed Software and/or the program(s) described in this publication
at any time.

The agents, distributors, employees and dealers of Vertigraph are not authorized to
modify this Agreement or to make statements, representations or terms binding
Vertigraph, Inc.  Accordingly, any statements, representations or terms not made or
given directly or expressly by Vertigraph are not binding on Vertigraph, Inc.

It is agreed that the laws of the State of Texas shall govern this Agreement.

Copyright - This program and related documentation is the confidential and
proprietary product of Vertigraph, Inc.  Any unauthorized use, reproduction or
transfer of this program and/or documentation is strictly prohibited and subject to
criminal prosecution.  Copyright 2002 by Vertigraph, Inc.  All rights reserved.
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II.  Getting Started

Overview
SiteWorx is designed to automate the calculation of cut and fill volumes using a
digitizer tablet.  The site plan's contour lines, proposed areas and spot elevations are
electronically entered into SiteWorx from the paper plans using a digitizer tablet.
Once this information is entered, SiteWorx calculates cut and fill volumes and
displays the information on-screen and on printed reports.  Quantities can easily be
exported to an Excel spreadsheet or Word document for additional analysis, pricing
and presentation.

With SiteWorx you'll perform the following:

• Prior to starting your first takeoff please click on the Options menu to
setup the SiteWorx application to your specifications.

• At the Overview tab, you'll enter project information, set the scale,
register the drawing and record the maximum, minimum and elevation
increment in feet or meters.

• Next, at the Takeoff tab you'll digitize project boundaries, topsoil strip
areas, topsoil respread areas, contour lines, point elevations and areas.
Any digitized area may contain subgrade materials.  Any digitized item
can be selected and its properties modified at any time.

• After items are digitized at the Takeoff tab, you'll click on the
Calculations tab to calculate cut and fill volumes.

• After calculating, the 3D View tab is where you'll see the site in 3D.
You can see the Existing or Proposed site.  The Cut/Fill view shows
where dirt needs to be cut and filled.

• The Grid Data tab shows the cuts and fills per grid and it also shows
the depth for staking out the site at the four corners of each grid.  The
grids are displayed at the Takeoff tab.  The Calculations tab is where
you specify the grid size.  The Stake heights are after topsoil strip depth
unless Stake Heights Before Topsoil Strip is checked under the
Options menu.

• After calculating, a variety of reports can be generated using the
Reports menu option and you're able to export the data to a variety of
programs (Word, Excel and others) using the Export menu option.
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Before Starting Your First Takeoff
Prior to starting your first takeoff, make sure the following actions have been
completed:

1. Digitizer with Wintab driver is correctly installed

2. Wintab driver is configured so that the digitizer pointing device
operates in relative (i.e. mouse mode).

3. The digitizer buttons have been configured correctly in the SiteWorx
program under the Options|Digitizer Buttons menu.

4. The command template has been correctly placed and located on the
digitizer by selecting the Options|Command Template menu option.

5. Select the grid color at Options|Takeoff Grid Color.  The takeoff grid
is found at the Takeoff tab and we suggest a light gray color for the
grid.

6. The desired number of decimal places for elevations, depths and
volumes have been defined at the Options|Decimal Places menu.

7. The 3D colors have been defined under the Options|3D Colors menu.
Select colors that have a high contrast is recommended. We often use
red for maximum, white for middle and blue for minimum elevations.

8. The names of the user defined fields are created by selecting the
Options|User Defined Fields menu.

9. The trace resolution is set at Options|Trace Resolution.

10. Under the Options menu, the following should be checked (i.e. turned
on by clicking on the item): Show Takeoff Toolbar, Show Takeoff
Properties, Show Takeoff Grid, Show Takeoff Elevations, Confirm
Deletions and possibly Stake Heights Before Topsoil Strip.

Once the above options have been set, you are ready to start your first takeoff using
the SiteWorx Practice Plan.

For additional information see page 16

Your First Takeoff using the Practice Plan
Please use the included Practice Plan for your first takeoff.

A page entitled Practice Plan for SiteWorx is included with the SiteWorx Users'
Guide.  This practice plan can also be printed from the installed pdf file.  The pdf file
is entitled SW_Practice.pdf and is found at C:\Program
Files\Vertigraph\SiteWorx\PDF Files.

If you download the SiteWorx application from Vertigraph's web page at
www.vertigraph.com please review all of the pdf files found at C:\Program
Files\Vertigraph\SiteWorx\PDF Files after installing.  Here, the SiteWorx Practice
Plan, command template and recommended button assignments are saved as pdf
files.

All comments in this section will apply to the Practice Plan included herewith.
Again, please print and use the included Practice Plan before digitizing any other
project.

Please perform the following to correctly takeoff the SiteWorx Practice Plan:
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1.  Review Before Starting Your First Takeoff
For additional information see page 7

2.  Tape the Practice Plan onto the digitizer
Tape or secure the plan inside the active area of the digitizer.

3.  Review the blueprint
What is the scale? What is the highest and lowest elevation? Where are the project
boundaries? Are there any excluded areas? Are there subgrade depths in the various
paving and building slab areas?  Is topsoil being stripped? Is topsoil being respread
and at what thickness?

4.  Mark the paper plan with three registration
points
Use a pencil or pen to identify three points on the plan.  The three points will define
the relevant digitizing area (i.e. rectangle).  When marking the actual drawing with
these three points, the points should be approximately ½ inch outside the actual
project boundary. The first point will be located in the upper left hand corner of the
digitized area, the second point will be in the bottom left hand corner of the digitized
area and the third point shall be in the lower right hand corner.  By digitizing these
three points, a rectangle is developed that defines the active digitizing area.  You will
not be able to digitize outside this registered rectangle.  If the drawing is moved on
the digitizer tablet, you’ll be able to re-register the drawing by digitizing the same
three points that you marked on the plan.  The Practice Plan has the three points
already defined as 1, 2 and 3.

5.  Open SiteWorx
Open the SiteWorx program and click on File|New to start a new project.

6.  Complete the Fields on the Overview Tab
Identify a project name and complete any of the user-defined fields on the Overview
tab.  The user defined fields are created at Options|User Defined Fields.

7.  Set the Scale
Set the scale by clicking on the Scale button at the Overview tab.  If English scale is
chosen you're able to select architectural or engineering scales by clicking on the
down arrow under the Select caption.  If a drawing is not to scale, click on the
yellow ruler to digitize the scale.  If digitizing the scale, click at the beginning and
end of a line using the point button of a 16 button cursor or use the tip of the pen
stylus and then type in the length (in decimal feet or meters) of the line.  The Practice
Plan requires a 1:40 engineering scale.  As a result, click on the Scale button and
select English, Engineering and then click the drop down list box (i.e. the down
arrow) to select 1:40.
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8.  Register the Drawing
Click on the Register button using the mouse to digitize the three points on the
drawing that were written onto the plan in step 4 above.  The Practice Plan has the
three points already marked at the corners as 1, 2 and 3.  As a result, digitize points
1, 2 and 3,

9.  Enter the Max Elevation, Min Elevation and
Elevation Increment
Enter the Max Elevation, Min Elevation and Elevation Inc (increment) at the
Overview tab.  You can use the min and max elevations to check for digitized
points, lines and areas that are above or below these elevations.  Elevation
Increment tells SiteWorx how the elevations are recorded on the plan.  If contour
lines are increasing by a foot on the drawing, Elevation Increment should be set to
1.  If the contour lines increase by 5 feet, the increment should be set to 5. When
digitizing, you can press a button on the cursor or digitizer template to increase or
decrease the elevation by this increment.  The Practice Plan should have an
Elevation Increment set to 1.

10.  Click on Takeoff Tab to Digitize
After entering the information at the Overview tab, click on the Takeoff tab to begin
digitizing.  Digitizing commands can be selected by clicking the digitizer cursor or
pen stylus on the command template taped onto the digitizer.  You can also make
selections from the top of the Takeoff tab using the mouse/keyboard or by pressing
the appropriate button on the 16-button cursor.  To make it easier, we suggest you
first begin digitizing by selecting the commands using the mouse at the top of the
Takeoff tab or by using the command template taped onto the digitizer.  After your
product knowledge increases, you may want to gain speed by entering information
using the cursor buttons.

11.  Digitize the Project Boundary
The first item to takeoff is the Project Boundary.  Using the mouse click on the
Takeoff tab and select Project Boundary from the Takeoff drop down list box at
the top of the window.  To the right of the word Project Boundary a Takeoff option
box is displayed.  For any boundary the Takeoff is either Include or Exclude.  An
Include area means that all information inside the digitized area will be included in
the calculations.  Likewise if Include is selected, all areas outside the boundary are
excluded from the cut and fill calculations.  Please note that the project boundary
will be the registered area, digitized at the Overview tab, if a project boundary is not
digitized at the Takeoff tab.

Within an Included project boundary, certain areas can be Excluded from the cut
and fill calculations.  As a result, Excluded Takeoff areas can be set inside Included
Takeoff areas.   IMPORTANT:   Display allows you to view both the included and
excluded areas by selecting Both or just the areas you are taking off by selecting the
Takeoff option.  If Takeoff is selected under the Display option, click on Include or
Exclude under the Takeoff section to view the desired area.

To begin digitizing click on the Start Digitizing tool button at the top of the Takeoff
tab with your mouse.  The Start Digitizing tools looks like a lightning bolt.  To
digitize the project boundary, click on any perimeter corner using the Point button on
the digitizer pointing device (usually the top left button if using a 16-button cursor or
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the pen tip if using a stylus pen) and then move to the next corner and again digitize
a point.  To digitize an area you'll usually click on the corners either clockwise or
counter clockwise around the perimeter rather than tracing around the perimeter.
Once complete, press the Stop Digitizing button on the command template or press
the Stop Digitizing button on the digitizer pointer (the top right hand button on a 16-
button cursor is often the Stop Digitizing button).  By pressing the Stop Digitizing
button, the area will be closed and the digitizer pointer will change from digitizer to
mouse mode.

12.  Copy the Boundary as a Topsoil Strip Area
After digitizing the project boundary you may copy the project boundary as a topsoil
strip, topsoil respread or area by pressing the right mouse button when the mouse
pointer is inside the project boundary.  In the Practice Plan, lets assume that the
entire project boundary will be stripped of 4" of topsoil.

To copy, press the right mouse button when the mouse pointer is within the grid and
select Copy as Topsoil Strip.  The Copy region dialog box appears whereby you'll
enter line colors, styles, descriptive name along with the topsoil strip depth in
decimal feet or meters.  If you are stripping 3", depth must be entered as .25.

In the Practice Plan, we'll assume that the entire project boundary will be stripped of
4" of topsoil.  As a result, after digitizing the project boundary, press the right mouse
button when located in the grid and select Copy as Topsoil Strip and complete the
Copy Region dialog with a depth of .333.

Topsoil strip areas can also be digitized like project boundaries by selecting the
Topsoil Strip command.

13.  Digitize Topsoil Respread Areas
If topsoil is respread on the site, select Topsoil Respread from the command
template.  Like the other defined regions (i.e. project boundary, topsoil strip and
topsoil respread), excluded areas can be nested inside included areas.  On the right
side of the included Practice Plan a light gray area is displayed with the heading Top
Soil Respread 6".  After pressing the Topsoil Respread button on the command
template, press the Incl (Include) button and then start digitizing the perimeter of the
Topsoil Respread area.  When completed press the Stop Digitizing button to close
the area and return the digitizer pointer to mouse mode.

After pressing the Stop Digitizing button, use your mouse to record fill styles,
colors, descriptive name and depth in decimal feet under the Properties tab on the
right hand side of the window.  For the Practice Plan, depth of the topsoil respread
area is 6"; as a result, depth is entered as .5 of a foot.

IMPORTANT:  After modifying any properties on the right hand side of the
window, click on the green Save Changes check mark tool to record the
changes.

14.  Digitize Contour Lines
The next items to digitize are the existing and proposed contour lines.  First we'll
digitize the existing contour lines from the Practice Plan.  The existing contours are
shown as either green or light gray lines on the Practice Plan and the existing contour
elevations are shown outside the project boundary.

First select the Contour Line button from the command template.  Next, click on the
Exist (short for Existing) button on the command template.  Finally, click on the Set
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Elevation button from the command template and using the digitizer pointing device
enter the elevation 100 using the number pad on the command template.  When done
entering the 100 number make sure you click down on the Enter button on the
command template to accept the elevation.  The 100-foot existing elevation line is in
the bottom right hand corner of the plan.  Now trace the 100-foot existing elevation
line into the computer using the Point button on the digitizer cursor or pen.  When
done with the 100-foot elevation line, press the Increase Elevation button on the
template to increase the elevation by 1.  Next trace the 101 elevation contour line.
When done with 101, click on the Increase Elevation command template button and
start digitizing the 102 line.  When completed with 102, press the Decrease
Elevation command to change the elevation to 101 and then start digitizing the 101
line.  If you press the Increase Elevation or Decrease Elevation more then once,
the elevations will change by the number of times the command is clicked with the
digitizer.  If the Set Elevation button is clicked, you must enter the elevation using
the number pad and click the Enter command to accept the elevation.  If the same
elevation is found on more than one existing contour line, you'll stop the one line and
start a new line by pressing the Increase Elevation and then the Decrease Elevation
command or by pressing the Set Elevation and then the Enter command.

Digitize the existing and proposed contour lines shown on the Practice Plan.

15.  Digitize Point Elevations
The point elevations found on the Practice Plan are proposed elevations.  Using the
16-button cursor (0 button) or pen stylus tip, click the following commands from the
template taped onto the digitizer:

• Point Elevation

• Prop for proposed

• Set Elevation

• Enter the elevation from the number pad (99 to start)

• Enter

Move the digitizer pointer over the bottom left side of the Practice Plan and click the
two 99 point elevations using the cursor or pen stylus.

To digitize the 99.25 point elevations on the right side of the Practice Plan click the
Set Elevation command from the command template and enter using the number
pad from the template the 99.25 elevation.  Again, always click on the Enter button
prior to digitizing the 99.25 point elevation on the Practice Plan.

16.  Digitize Areas
Digitize the two proposed areas.  First will digitize the top of finished floor by
pressing the following commands from the template:

• Area Elevation

• Prop for proposed

• Set Elevation

• Enter the elevation from the number pad (104)

• Enter
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Click the digitizer pointer down using the Point button on any corner of the finished
floor area.  Next move (either clockwise or counter clockwise) to the next corner and
press down again.  Once you have digitized the four corners, click the Stop
Digitizing command to close the area and return to mouse mode.

After digitizing you're able to change any of the properties on the right side of the
window.  Elevation changes are done at the Corners tab.  Remember after making
changes at the Properties tab click the green Save Changes check mark above the
tabs to record the changes.

After digitizing the area, click on the Layers tab to enter the subgrade materials and
depths.  After clicking on the Layers tab, subgrade materials are added by clicking
on the commands at the bottom of the screen.  The plus command adds a new record.
The check mark posts any changes made to the record.  After digitizing the top of
finished floor area from the Practice Plan, click on Layers tab to add the Sand
material with a depth of .333 and the Concrete with a depth of .5.  Remember press
the check mark button to record the changes.

The second area is a parking lot.  The proposed elevations have been entered as
contour lines and point elevations previously.  The proposed contour line elevations
entered are at the top of the 8" asphalt material however.  As a result, after digitizing
the area, change the area type to Subgrade Only on the Properties tab and then
press the green check mark to save the changes.  Elevations are not required for
Subgrade Only areas.  The subgrade material depth recorded on the Layers tab
however would reduce all proposed elevations, within the area.  Next click on the
Layers tab to enter the 8" (.667 of a foot) of asphalt using the commands at the
bottom of the window.

In summary, areas types defined at the Properties tab are either:

• Surface which contain elevations.  Top of finished floor is an example
of a Surface area.

• Subgrade Only areas do not require elevations.  Sloping Parking lots
are examples of Subgrade Only areas.  When calculating dirt volumes,
any proposed point and line elevations contained within a Subgrade
Only area will be adjusted for any subgrade material depths entered at
the Layers tab.

• Other is for used to digitize areas for the sake of knowing the area.
Other areas do not affect the cut and fill calculations.

17.  Calculate
After all items are digitized, click on the Calculations tab to enter the topsoil discard
percentage along with topsoil strip swell and the swell factor for any topsoil
imported to the site.  Additionally, enter the site swell and import swell for the non-
topsoil cut and fill quantities.  After the swell factors are entered, click on the
Calculate button to arrive at cut and fill volumes.

Please note the following regarding the Calculations window:

• The Total Cut volume shown on the right side of the Calculations tab
is before removing the topsoil stripping volumes.  The Total Cut
volume is the total of the topsoil strip volume and the subsoil cut
volume.  The Total Fill is after topsoil respread volumes have been
respread.  As a result, Total Fill equals topsoil respread volume plus
subsoil fill volume.  Subsoil Cut volume is the volume to be cut after
the topsoil volume has been stripped away.  A negative subsoil cut
volume implies fill is required.  Subsoil fill is before topsoil is respread
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onto the site.  Like subsoil cut, a negative subsoil fill number implies a
cut is required.

Total Cut = Topsoil Strip + Subsoil Cut

Total Fill = Topsoil Respread + Subsoil Fill

• Site balancing at the bottom of the sheet tells you how proposed
elevations need to be adjusted in order to arrive at a balanced site.  A
balanced site is where borrow (i.e. import) is equivalent to spoil (i.e.
export).

• LCY represents the volume of loose dirt required to fill the site or the
amount of loose dirt that needs to be hauled off.

• Grid Size determines the size of the grid displayed at the Takeoff tab.
Information at the Grid Data tab is calculated based on the grid size
defined here.  The detail of the view displayed at the 3D View window
is also affected by the grid size.

• Resolution is used to define the calculation resolution.  The higher the
resolution, the more calculations are preformed on the digitized input to
arrive at the calculated results.  The results may be more accurate at the
expense of increased time to calculate.

• If the Equate Outside Bounds check box is checked, the existing and
proposed elevations will be equal outside the project boundary.
Otherwise, when the 3D view is displayed, the elevation outside the
project boundary will equal the proposed elevations at the project
boundary perimeter. This check box only affects the view displayed at
the 3D View window however.

18.  Review the 3D View
Display 3D existing and proposed site by clicking on the 3D View tab.  The 3D
views can be rotated and zoomed by clicking on the Zoom bottom on the right side
of the window.  When zooming into the image, click on the center of the image and
drag and drop the mouse pointer to the project boundary.  Dragging and dropping the
mouse pointer performs all zoom actions.

If elevations look incorrect, go back to the Takeoff tab to edit the properties of any
selected item.  To select an object at the Takeoff tab, make sure Display is set to
Takeoff and click on the Select command from the template or press the yellow
finger tool on the toolbar to select an item.  Once the command is pressed, the mouse
pointer should display a box to select any point within an object.  If the mouse
pointer does not change to a selection box make sure none of the zoom or pan
commands on the right side of the window are depressed.

19.  Review Grid Data
After calculating the project at the Calculations tab, Cut and fill data per grid is
displayed at the Grid Data tab.  The cut and fill depths at each corner of the grid are
also displayed.  O.B. under the stake columns indicates that the corner is outside (i.e.
out of bounds) the project boundary.  The stake heights may be before or after
topsoil stripping.  If Stake Heights before Topsoil Strip is checked at the Options
menu then the depths in the stake columns on the Grid Data page are before the
topsoil has been stripped.  If not checked under the Options menu, the values are
after the stripping.
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20.  Print Reports
View and print reports by making selections from the Report menu when at the
Calculations or 3D View tab.  Data can also be exported my selecting the
Export|Cut/Fill menu command.
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III.  Menu Options

File

New
Select the File|New menu option to create a new project file.

Open
File|Open lets you select a previously saved SiteWorx project file.  All SiteWorx
project files have a .ved extension.  Lists of recently used files are also displayed at
the bottom of the File submenu.

Save
Selecting File|Save saves all changes to the file since the last time the file was saved.
If a file has not been previously saved, the Save As dialog box opens so that a new
file name for the project can be entered in the computer.

Save As
File|Save As allows you to rename the opened file.  All SiteWorx files have a .ved
extension.  Only one SiteWorx project file can be opened at any time.  The file name
and path of the project file you are working with is displayed at the bottom right
hand corner of the SiteWorx window.

Print Setup
File|Print Setup contains the typical interface for defining the printer and page
layout.

Exit
Selecting File|Exit closes the SiteWorx program.
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Options
The Options menu is where you make various user defined selections.  Once the
options are set, you’ll rarely change these settings.

Digitizer Buttons
You must set up the digitizer buttons before starting your first takeoff.  Once the
digitizer buttons are configured you will not need to select this menu option again
unless you want to make changes.

We recommend using SiteWorx with a 16-button cursor instead of a pen stylus.  If
using a pen stylus with SiteWorx, digitizing commands will need to be selected
using either the digitizer template located on the digitizer or the mouse.  With a 16-
button cursor, digitizing commands can be selected from the buttons found on the
16-button cursor.

The Options|Digitizer Buttons window has a Cursor Style and Buttons tab.  The
Cursor Style tab is where you select the type of digitizing pointing device.   At the
Cursor Style tab you can also select where the button names found at the Buttons
tab come from.  Selecting Default for button names is easiest. After making the two
selections at the Cursor Style tab, click on the Buttons tab to configure the digitizer
buttons.

A sheet of paper with the recommended button assignments is included with the
users’ guide.  This document is also saved as a pdf file a C:\Program
Files\Vertigraph\SiteWorx\pdf Files\SiteWorx Recommended Button Setup.pdf.
This piece of paper can be taped to the digitizer for reference.  Recommended button
assignments are displayed below:

Button Action

0 Point

1 Toggle between existing and proposed or include and exclude

2 New object - lets you stop a measurement and start a new one with
the same elevation (useful for digitizing multiple contour lines with
the same elevation)

3 Stop digitizing and return to mouse mode

4 Select an object to edit (Cursor changes to a selection box)

7 Popup menu allows you to change objects

8 Delete last point

C Increase elevation by increment noted at the Overview tab

D Decrease elevation by the increment noted at the Overview tab

F Set Elevation (once pressed, elevations can be entered via the cursor)

Various sounds can be assigned to each button by selecting a sound from the drop
down list box.  If WAV File is selected from the list, a specific *.WAV file can be
opened by clicking on the three dot lookup button.  Under the windows or WinNT
folder there is a Media subfolder that contains a variety of .WAV files.  After
selecting the sound or WAV file, listen to the sound by clicking on the Test button.
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When digitizing items with a 16-buton cursor, clicking on the Set Elevation button
(i.e. Button F) allows you to enter elevations using the 16-button cursor.  As a result,
clicking the F (Set Elevation) button changes how the buttons operate.

Once the F button is pressed to set an elevation, the 16-button cursor buttons change
to allow input of elevations.   Please note the following button assignments once the
set elevation button (i.e. F) is pressed:

Button(s) Action

0-9 The 0-9 buttons represent the numbers shown on the buttons

A Toggles between positive and negative

B Backspace

C Restore Original Value

D Decimal Point

E End

F Finish entering elevations so that digitizing can begin

Command Template
Digitizer templates are supplied with the software and manual.  The horizontal
template should be attached to the bottom (normally right) edge.  The vertical
template should be taped to the right edge of the active area of the digitizer.

After taping the digitizer templates to the active area of the digitizer, select
Options|Locate Command Template to instruct SiteWorx which one of the two
templates you are going to use.  The vertical template commands run up and down
whereas the horizontal template runs from side to side.

If using the horizontal template, configure the template by clicking on the point
button  (0 button on the 16-button cursor or tip of the pen stylus) when the crosshair
is located over the bottom left hand corner of the Stop Digitizing command.  Next,
press the 0 button again when the crosshair is on the top right hand corner of the
minus sign command.

If using the vertical template, configure the template in a similar manner.

User Defined Fields
Click on Options|User Defined Fields|Setup to define the user defined field
captions.   After defining the field captions, information is entered into the user-
defined fields at the SiteWorx Overview tab.  A variety of data may be entered here.
For example, you may want a field called Estimator’s name so that the estimator can
entered his or her name with the estimate. Once you have defined the user defined
fields, click on Options|User Defined Fields|Save As Default so that each new
project file you create will contain these field captions.

The "use field caption in title" selection will print the field caption on all printed
reports if this box is checked.  Otherwise, if this is not checked only the data entered
into the field will be printed and the caption only appears on the Overview window.

Possible user defined fields may include:

• Project Name

• Project Location
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• Estimator Name

• Status (i.e. low bidder and won, pending, etc.)

• Bid Date

Show Takeoff Toolbar
A checkmark next to this command indicates that the takeoff toolbar is displayed.
We recommend that you always display the takeoff toolbar.

Show Takeoff Properties
A checkmark next to this command indicates that the takeoff properties are displayed
on the right side of the Takeoff tab window.  We recommend that you always
display the takeoff properties.

Show Takeoff Grid
A checkmark next to this command indicates that the grid is displayed at the Takeoff
tab.  We recommend that you always display the takeoff grid.

Show Takeoff Elevations
A checkmark next to this command indicates that the elevations are displayed at the
Takeoff tab for points and contour lines.

Takeoff Grid Color
Click on Options|Takeoff Grid Color to change the color of the grid found at the
Takeoff window.  A light gray color is the recommended default.   

Decimal Places
Click on Options|Decimal Places to set the number of decimal places for elevations,
depths of subgrade, topsoil strip and topsoil respread areas.  You’ll also instruct
SiteWorx in how many decimal places are displayed for volumes.   

3D Colors
Click on Options|3D Colors to select the colors to display on the elevation scale.
When selecting the three colors, use colors that show a high contrast.

Click on Options|3D Colors to select the colors to display on the elevation scale and
on the 3D drawings.  When selecting the three colors, use colors that show a high
contrast.

We suggest bright red for maximum elevations, white for middle elevations and
bright blue for minimum elevations.

Save Takeoff Properties
Click on Options|Save Takeoff Properties to save the default line styles for the
various objects. Once you make changes to these properties at the Takeoff tab,
clicking here will save the changes and apply the changes to future projects.



Users' Guide for SiteWorx III.  Menu Options  •  19

Confirm Deletions
If Options|Confirm Deletions is checked, SiteWorx will prompt you before deleting
an entire object (such as a contour line, point, area or region) and for each digitized
point.

Trace Resolution
Trace resolution sets the number of points generated per inch when lines are traced.
The higher the resolution the more points generated the greater the accuracy and the
larger the file size.  We suggest selecting either 20 or 50 points per inch.

Soil Factors
Options|Soil Factors lets you change the soil factors at the Calculations tab and
then save the new factors as the default for new projects.

Stake Heights Before Topsoil Strip
If Options|Stake Heights Before Topsoil Strip is checked then the stake heights at
the Grid Data tab will show stake heights before the topsoil strip depth.
Alternatively, if this option is not checked, then the stake heights at the Grid Data
tab will be at the depth after the topsoil has been stripped from the site.

Takeoff
After registering the drawing at the Overview tab, you’re able to make takeoff
selections from the Takeoff drop down list box when you are clicked on the Takeoff
tab.  You're also able to make selections from the command template taped to the
digitizer or from the Takeoff menu.  The Takeoff menu commands are listed below:

Takeoff Menu Items
The Takeoff tab is where you’ll digitize information into SiteWorx.  The items that
can be taken off include:

1. Project Boundary

2. Topsoil Strip regions

3. Topsoil Respread regions

4. Contour lines

5. Point elevations

6. Areas

To takeoff any of the above items, click on the appropriate command from the
command template taped to the digitizer, from the drop down list box found at the
top of the Takeoff tab window or from the Takeoff menu.

Items 1 through 3 above are considered regions and can be defined as an Included or
Excluded region.  Usually all items digitized in 1 through 3 above are included.
However, you can nest and excluded area within a previously digitized Include
region.  As a result, when digitizing regions (i.e. boundary, topsoil strip or topsoil
respread) you’ll need to specify the region as either an Include or Exclude region
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from the top of the Takeoff tab window or from the command template taped to the
digitizer.

After digitizing a project boundary you click the right mouse button to copy the
project boundary as a topsoil strip, topsoil respread or area elevation.

Items 4 through 6 above are defined as either existing or proposed elevation items.
When digitizing contour lines, points and areas you’ll need to specify if the item
being digitized is Proposed or Existing along with the item’s elevation.  Again, like
included or excluded, you’ll need to specify the digitized item as either an Existing
or Proposed item from the top of the Takeoff tab window or from the command
template taped to the digitizer.

 A project boundary, topsoil strip or topsoil respread area is digitized by selecting the
command from the menu, template taped onto the digitizer or from the takeoff list at
the top of the Takeoff tab.  After the command is selected (press the Start Digitizing
button, lightning bolt, if the command was selected by mouse from the drop down
list box or menu), click the Point button on the cursor or pen stylus as you move
around the perimeter of the area with the digitizer pointer.  Once done, pressing the
stop-digitizing button closes the area and returns the digitizer pointer to mouse mode.

To digitize contour lines, point elevations or area elevations, you'll need to enter an
elevation.  Elevations can be entered using the mouse and keyboard at the top of the
Takeoff tab window or by using the commands and number pad found on the
template taped to the digitizer.  If elevations are entered from the taped template
using the Set Elevation command, you'll need to click on the Enter command on the
template after entering the elevation before digitizing.

Once items are digitized, properties of the item digitized along with elevations and
area subgrades (i.e. layers) are displayed on the right side of the Takeoff tab window
and can be changed at any time.

Areas can be defined at the Properties tab as either:

• Surface which contain elevations.  Top of finished floor is an example
of a Surface area.

• Subgrade Only areas do not require elevations.  Sloping Parking lots
are examples of Subgrade Only areas.  When calculating dirt volumes,
any proposed point and line elevations contained within a Subgrade
Only area will be adjusted for any subgrade material depths entered at
the Layers tab.

• Other is for used to digitize areas for the sake of knowing the area.
Other areas do not affect the cut and fill calculations.

For additional information see Your First Takeoff using the Practice Plan starting on
page 7.

Delete Last Point
This command deletes the last digitized point.

Stop Takeoff
Stop takeoff closes an area takeoff and changes the mouse pointer from digitizer
mode to mouse mode.
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Increase Elevation
Pressing this command increases the elevation by the increment defined at the
Overview tab.

Decrease Elevation
Like the Increase Elevation command, pressing this command decreases the
elevation by the increment defined at the Overview tab.

Checking
When at the Takeoff tab, you’re able to search for items outside the minimum and
maximum elevations recorded on the Overview tab.  In order to use the Checking
menu, the Display must be set to Takeoff rather than Both at the Takeoff tab.
Takeoff will be Existing or Proposed (or Include/Exclude) depending on the setting
under the Takeoff caption.

To find all items with an elevation above the maximum elevation noted at the
Overview tab click on Checking|Above Maximum when the Takeoff is Point
Elevation, Contour Line or Area Elevation.  Likewise, to find all items with an
elevation below the minimum elevation noted at the Overview tab click on
Checking|Below Minimum.  Checking|Points in Area shows you all existing or
proposed points found inside an existing or proposed area.  Points in Area checking
works like this:

1) You must have the Display set to "Takeoff"

2) Select Area Elevation

3) Select Existing or Proposed.

4) Select the Area by selecting any point along the perimeter using the
square select mouse pointer

5) Change the takeoff to Point Elevation

6) Click on the Checking|Points in Area menu command.

Checking|Invalid Areas is used when displaying Area Elevations at the Takeoff
tab.  Invalid areas could result from not enough digitized points, etc.

Please note that you can change the minimum and maximum elevation settings at the
Overview tab, at any time, to broaden or narrow your search for items.

Reports
After the project has been calculated at the Calculation tab, a variety of reports are
available.

Area
The Area report lists all the areas with its perimeter and area measurement.  If
subgrades are attached to the area, a list of the subgrade volumes for each area is also
presented.
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Material Volumes
The Area Volumes Report summarizes the subgrade materials for the entire project.

Cut/Fill
The cut and fill report shows cut and fill volume by grid along with the cut and fill
depth at each of the four corners of every grid.  The cut and fill volumes for the
entire project are also displayed.  The grid size is specified at the Calculations
window.

3D
The 3D report prints the proposed or existing site in 3D when you are clicked on the
3D window.

Takeoff
The Takeoff report shows you plan view of the site of the various items you have
taken off.  You can select which items to display on this report.

Font
Selecting the Reports|Font command enables you to change the font on the printed
report.

Export
SiteWorx calculates a variety of information that can be easily exported into MS
Excel, Word and other file formats by selecting the Export|Cut/Fill menu option.

Cut/Fill
After a project has been calculated at the Calculations tab, information can be
exported into Word, Excel and other file formats.   Several tabs are found on this
dialog:

Export Type
Export Type is used to select the file format and name the destination file.  After the
destination files has been named and all the other tabs have been completed, you're
able to export the file by clicking on the Start Export button.

Fields
Fields is a listing of the available fields that can be exported.  To select a field, move
the field from the available field box to the exported field box.

Formats
Formats lets you specify number and date formats.  Files exported into Excel can
also be formatted in the MS Excel application.
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Header & Footer
Header and Footer enable you to put desired text at either the top or the bottom of the
report.

Captions
Captions enable you to change the column captions or headings for the exported
fields.

Options
Depending on the file type selected, additional formatting options may be found
here.

Help

Contents
Contains the chapter headings for the SiteWorx.hlp file

Index
Enables you to search through the Help file by keyword.

Help on Help
Provides general information on Windows and SiteWorx help.

Tool Tips
If Tool Tips is checked, popup hints are provided on each icon.

Digitizer Info
If the Wintab driver is loaded, this menu option will provide Wintab driver
information.  If no information is found here, you’ll need to install the Wintab driver
for the digitizer.

Register
If SiteWorx has been registered with Vertigraph, your serial number and registration
number will be found here.  If you have not previously registered, click here and
contact Vertigraph at 800-989-4243 (US and Canada) or 214-340-9436 (other
countries) to receive a registration number and serial number.  You can also receive
the numbers via Email by sending your customer code to info@vertigraph.com

About
Contains information about the SiteWorx application.
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IV.  SiteWorx Tabs

Overview
The Overview tab must be completed prior to selecting any other tab.  At the
Overview tab you’ll enter the project name and complete any of the other user-
defined fields.  User-defined fields can be setup at the Options|User Defined Fields
menu.

Other items that must be defined at the Overview window include:

Scale
Select a scale from the drop down list box.  If you click on the yellow ruler at the
scale dialog box you can digitize the beginning and ending points of a line with a
known distance, enter the distance (in decimal feet or meters) between the points and
have SiteWorx calculate the scale.

Register
Using a pencil or pen, mark the three points on the blueprint that are going to be used
to register the drawing.  By registering the drawing, you're defining the active
digitizing rectangle.  When marking the actual drawing with these three points, the
points should be approximately ½ inch outside the actual project boundaries. The
first point will be located in the upper left hand corner of the drawing, the second
point will be in the bottom left hand corner of the blueprint and the third point shall
be in the lower right hand corner.

Click on the Register button and digitize, using the digitizer pointing device point
button, the three points that you marked on the drawing.  By digitizing these three
points, a rectangle is developed that defines the active digitizing area.  Additionally,
if the drawing is moved on the digitizer tablet, you’ll be able to re-register the
drawing by digitizing these same three points.

Max Elevation
Review the plan and enter in the maximum elevation here.  When checking the
takeoff at the takeoff window, information entered here will be used to filter out
desired points, lines or areas.
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Min Elevation
Review the plan and enter in the minimum elevation here.  When checking the
takeoff at the Takeoff tab, information entered here will be used to filter out desired
points, lines or areas.

Elevation Increment
When increasing or decreasing elevations using the digitizer template or buttons on
the 16-button cursor, the elevation will increase or decrease based on this specified
increment.

Takeoff

Items to Takeoff
The Takeoff tab is where you’ll digitize information into SiteWorx.  The items that
can be taken off include:

1. Project Boundary

2. Topsoil Strip regions

3. Topsoil Respread regions

4. Contour lines

5. Point elevations

6. Areas

To takeoff any of the above items, click on the appropriate command from the
command template taped to the digitizer, from the drop down list box found at the
top of the Takeoff tab window or from the Takeoff menu.

Items 1 through 3 above are considered regions and can be defined as an Included or
Excluded region.  Usually all items digitized in 1 through 3 above are included.
However, you can nest and excluded area within a previously digitized Include
region.  As a result, when digitizing regions (i.e. boundary, topsoil strip or topsoil
respread) you’ll need to specify the region as either an Include or Exclude region
from the top of the Takeoff tab window or from the command template taped to the
digitizer.

After digitizing a project boundary you click the right mouse button to copy the
project boundary as a topsoil strip, topsoil respread or area elevation.

Items 4 through 6 above are defined as either existing or proposed elevation items.
When digitizing contour lines, points and areas you’ll need to specify if the item
being digitized is Proposed or Existing along with the item’s elevation.  Again, like
included or excluded, you’ll need to specify the digitized item as either an Existing
or Proposed item from the top of the Takeoff tab window or from the command
template taped to the digitizer.

 A project boundary, topsoil strip or topsoil respread area is digitized by selecting the
command from the menu, template taped onto the digitizer or from the takeoff list at
the top of the Takeoff tab.  After the command is selected (press the Start Digitizing
button, lightning bolt, if the command was selected by mouse from the drop down
list box or menu), click the Point button on the cursor or pen stylus as you move
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around the perimeter of the area with the digitizer pointer.  Once done, pressing the
stop-digitizing button closes the area and returns the digitizer pointer to mouse mode.

To digitize contour lines, point elevations or area elevations, you'll need to enter an
elevation.  Elevations can be entered using the mouse and keyboard at the top of the
Takeoff tab window or by using the commands and number pad found on the
template taped to the digitizer.  If elevations are entered from the taped template
using the Set Elevation command, you'll need to click on the Enter command on the
template after entering the elevation before digitizing.

Once items are digitized, properties of the item digitized along with elevations and
area subgrades (i.e. layers) are displayed on the right side of the Takeoff tab window
and can be changed at any time.

Areas can be defined at the Properties tab as either:

• Surface which contain elevations.  Top of finished floor is an example
of a Surface area.

• Subgrade Only areas do not require elevations.  Sloping Parking lots
are examples of Subgrade Only areas.  When calculating dirt volumes,
any proposed point and line elevations contained within a Subgrade
Only area will be adjusted for any subgrade material depths entered at
the Layers tab.

• Other is for used to digitize areas for the sake of knowing the area.
Other areas do not affect the cut and fill calculations.

For additional information see Your First Takeoff using the Practice Plan starting on
page 7.

Zoom and Pan Commands
You can zoom in, zoom out, pan, zoom to selection and resize the grid to fit into the
window using the tools found on the right hand side of the window.

Display Option
The display option will either include the takeoff items (i.e. either included or
excluded for regions and either existing or proposed for contour lines, points and
areas) or both.  If Both are selected, existing and proposed will both be shown for
elevation items.  If Both is selected for regions (i.e. topsoil and project boundaries),
included and excluded will be shown.

Start Digitizing Tool
If the digitizer-pointing device is acting like a mouse, click on the Start Digitizing
tool on the top right hand side of the window before digitizing or operating the
digitizer template.  The Start Digitizing tool looks like a lightning bolt.

Select Object to View and Edit
If you desire to view or edit the properties for any items displayed, click on the
Takeoff option under Display and then click on the Select Object tool (it looks like a
pointed finger) and the mouse pointer will change to a selection box.  Please note
that you can also call the select command from the 16-button cursor and digitizer
template.  After clicking the Select command, move the selection box over an item
and the item’s color will change if it is selected.
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If the mouse pointer does not change to a selection box, make sure no tool buttons
(i.e. zoom, pan, etc,) are pressed at the top of the Takeoff tab window.

If a line only has two points, place the selection box at the beginning or end of the
line to select.  It is best to place the selection box over a change in direction for the
item you are trying to select in order to have it selected.  If you desire to view the
properties for a selected item it is not required that you click on the object.  By
placing the square mouse pointer over the object, the properties for the item will be
displayed on the right side of the screen.  If you want to edit the properties on the
right hand side, click on the object to edit.

Properties Information on the Right Side
Various attributes pertaining to a selected object is shown on the right hand side of
the screen.  After pressing the Select button, moving the mouse pointer over an
object will change the properties accordingly.  To edit an object, click on it with the
square selection box, make the changes and then click the green check mark to
accept the changes.  If you seek to delete an item, click on the item after pressing the
Select button and then click the delete object button.

For items that are measured as an area (i.e. project boundaries, topsoil strip and
topsoil respread and area elevation) the properties dialog will contain a corners tab
that contains X, Y coordinates.  For area elevations each corner will also show an
elevation.  If you want to see the elevation of a particular corner, click on the corners
tab and click the Select command and move the square mouse pointer over the
corner and the corner noted on the corner tab will change accordingly.

Other Items to Note at the Takeoff Window
Please note the following regarding the Takeoff window:

• All projects should contain a Project Boundary.

• Topsoil strip and topsoil respread areas require a depth.  You can have
multiple topsoil strip regions with different depths. Ditto for respread.

• Area elevations can contain subgrades, which are identified by material
type at the Layers tab that is found on the right side of the window.

• The elevations for contour lines and points can be displayed by
checking the Options|Show Elevations command.

Calculations
At the Calculations tab please note the following:

• Whenever you open a project file, you’ll need to calculate the project.
The calculated results are not saved with the file but are created each
time the Calculate button is pressed.

• Anytime changes are made at the Takeoff tab you’ll need to calculate
the project by clicking on the Calculate button.

• You’ll need to calculate the project before any reports can be viewed or
printed.

• Grid spacing displayed at the Takeoff tab is changed here.  Cut and fill
totals are displayed on the right side of this window and results by each
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grid are shown at the Grid Data tab.  Smaller grid spacing also
increases the detail found in the 3D views.

• The Equate Outside Bounds check box sets the proposed elevations to
the existing elevation immediately outside the project boundaries.

• A topsoil discard percentage can be entered at the Calculations tab.
For example, if 4” of topsoil is stripped and the top 1 inch is deemed to
be roots that is to be discarded, enter 25% as the discard percentage.

• Enter the Site swell and Import swell factors for the topsoil and subsoil.
Compression is the reciprocal of the swell factors.  Site Swell pertains
to dirt that is exported or spoiled.  Import swell pertains to dirt that
needs to be imported to the site (i.e. borrowed).

• Project area by square feet and acres is disclosed on the right side of the
window.

• The Total Cut volume shown on the right side of the Calculations tab
is before removing the topsoil stripping volumes.  The Total Cut
volume is the total of the topsoil strip volume and the subsoil cut
volume.  The Total Fill is after topsoil respread volumes have been
respread.  As a result, Total Fill equals topsoil respread volume plus
subsoil fill volume.  Subsoil Cut volume is the volume to be cut after
the topsoil volume has been stripped away.  A negative subsoil cut
volume implies fill is required.  Subsoil fill is before topsoil is respread
onto the site.  Like subsoil cut, a negative subsoil fill number implies a
cut is required.

Total Cut = Topsoil Strip + Subsoil Cut

Total Fill = Topsoil Respread + Subsoil Fill

• Site balancing at the bottom of the sheet tells you how proposed
elevations need to be adjusted in order to arrive at a balanced site.  A
balanced site is where borrow (i.e. import) is equivalent to spoil (i.e.
export).

• LCY represents the amount of loose dirt required to fill the site or the
amount of loose dirt that needs to be hauled off.

3D View
After calculating the project at the Calculations tab, clicking on the 3D View tab
displays the site in three dimensions.  If Plan is selected, the display will not be in
3D but rather plan view.  You can also select to view the existing or proposed site.
The Cut/Fill option shows where dirt needs to be cut and filled.  The Display
Outside Bounds check box displays the site outside the project boundaries.  If
Display Outside Bounds is not checked only the information inside the included
project boundaries is displayed.

Zoom commands can be selected by clicking on the Zoom button on the right side of
the window.  Use your mouse to select the zoom option and then drag the mouse
over the image to resize.  The Z scale defaults to 1 but can be increased to show
more contrast on elevation changes.  Show mesh should normally be checked at the
Zoom window.  The Reset button displays the image to the default setting.  If Zoom
and Rotate is selected, the left mouse button when it is held down rotates the drawing
and the right mouse button when it is held down zooms the drawing.
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Grid Data
Grid Data contains information used in building the reports.  This information is
read only and can not be changed at the Grid Data tab.  If a stake does not have a
cut or fill depth because it is outside an included boundary, O.B. (meaning out of
bounds) will be shown.  The grid spacing is defined at the Calculations tab.
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V.  Other Important Information

Troubleshooting and Important Items
Please consider the following items when operating SiteWorx:

Can't see the Toolbar, Properties, Grid or
Elevations
Make sure the following are checked (i.e. turned on) under the Options menu:

• Show Takeoff Toolbar

• Show Takeoff Properties

• Show Takeoff Grid

• Show Takeoff Elevations

Save the File
The information is only saved when the File|Save menu is clicked.  As a result, save
the project file frequently. The calculated results, 3D view and resulting grid data are
not saved with the file.  As a result, once changes are made to the Takeoff or
Calculations page, you'll need to Calculate at the Calculations tab before the
changes are displayed at the Calculations, 3D View or Grid Data tabs.
Additionally, when first opening a file, you'll need to calculate the project before
clicking on the 3D View and Grid Data tabs.

I can't digitize
If you are unable to digitize please note the following:

• Is the Wintab driver loaded properly (i.e. can you use your digitizer
pointer to move the mouse pointer on screen)?

• Is the digitizer configured with the proper setup code?  GTCO
digitizers require the setup code of S01 from the digitizer superset
menu.

• Is the digitizer turned on?  Are the cables securely fastened?
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• Are the buttons assigned under the Options|Digitizer Buttons menu?
The pen stylus or top left must button on a 16-button cursor must be set
to Point.

• Under Options|Command Template is the command template
properly placed and registered?

The increase or decrease elevation command does
not seem to work
In order for the Increase or Decrease Elevations commands to work, an Elevation
Increment is required at the Overview tab.

I get digitizing errors after pressing the Set
Elevation command on the template.
Remember you must press the Enter command on the command template after
entering the elevation.

Why doesn't the command template work
The command template must we enabled and set at the Options|Command
template menu.  Is the command template within an active area of the digitizer?  Are
you pressing the correct button on the pointing device?  Is the button you are
pressing defined as Point at Options|Digitizer Buttons? Is the Wintab driver
properly loaded?  Is the digitizer turned on and connected to the computer?  If the
above does not solve the problem, please contact Vertigraph for additional help.

Why can't I click on any other tabs?
You must Register the blueprint at the Overview tab before any of the other tabs
become active.

The calculated results appear incorrect, Why?
Calculated results are based on the information entered.  As a result, click on the 3D
View tab to see if the site appears proper.  If the 3D View looks incorrect, click on
the Takeoff tab to review each item digitized.  Is a digitized region properly
identified as an Included or Excluded region?  Are Topsoil Strip and Respread
depths correct?  Are Points, Areas, and Contour Lines correctly identified as
Proposed or Existing?  Are the elevations correct?  You can make changes to items
selected at the Takeoff tab by changing the properties, elevations and layers (i.e.
subgrades).  After changing properties click on the green check mark to record the
change.

Also please use the Checking menu option to find invalid areas along with incorrect
elevations.

The 3D View looks wrong, how do I find the error?
Review item properties at the Takeoff tab and use the Checking menu option to find
elevations outside the min and max elevations noted on the Overview tab.
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How do I edit an item that was digitized
incorrectly?
To edit any item's properties, click on the Takeoff tab and select the Takeoff item
from the drop down list box.  Set the Display to Takeoff at the top of the window
and make sure no buttons (zoom, pan or start digitizing buttons) are pressed on the
top right side of the window.  Next click on the yellow finger Select Object button
with the mouse and then move the mouse pointer over the grid.  The mouse pointer
should change to a square box.  Click on any point contained in a digitized item and
the item selected will change colors.  The Properties window for the selected item is
displayed on the right side of the screen.   After making any changes, click on the
green Save Changes button above the Properties tab.

You can also make changes to the elevations noted at the Corners and Layers tab
when selecting an Area Elevation item.

I incorrectly deleted an item, how do I prevent this
mistake?
To prevent unwanted deletions, please turn on the Confirm Deletions command
under the Options menu.

I lost my command template, where do I get a new
template?
The command templates, practice plan and other information are saved as a pdf files
at C:\Program Files\Vertigraph\SiteWorx\Pdf Files.

How do I change the soil swell factor used on new
projects?
To change the soil swell factors for new projects click on Options|Soil Factors|Save
as Default.  Whatever soil factors are entered at the Calculations tab will be the soil
factors used on any new projects.

Are the Stake Heights at the Grid Data tab before
or after topsoil strip depths"
If Options|Stake Heights before Topsoil Strip is checked, the stake heights at the
Grid Data tab is before the topsoil is stripped, otherwise the stake heights are after
the topsoil stripping.

How do I change the display of the 3D drawing?
Change from Existing, Proposed or Cut/Fill by clicking on the options at the top of
the screen.  The image can be zoomed, panned and rotated by clicking on the Zoom
button on the top right side of the window.

When at the Zoom window, you'll drag and drop the mouse pointer to move the
images.
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I am having problems with the reports, why?
Do you have the latest printer driver for your brand of printer?  Are you printing on a
color or black and white printer?  We highly recommend that you use an ink jet color
printer.

I do not see existing and proposed contours on the
screen at the same time
You can view either both or just the items your are taking off by clicking on the
Display option at the top of the Takeoff window.

Why does it say Not Register on the Overview tab
when I just called Vertigraph and entered my
registration number?
There is a difference between registering the SiteWorx application with Vertigraph
and registering the drawing for each project.

What do I do when the Proposed is on a Different
Sheet or Scale than Existing?
If the proposed grades are on a different sheet or scale than the existing grades
simply register the new registration points on the new drawing.  The registration
points must be the same three points on both drawings.  You will not need to change
the scale since the scale is automatically adjusted by the registered points on the new
drawing.


